Excel 2016: Formulas & Functions
# Table of Contents

Formulas and Functions ................................................................. 1

Formulas ......................................................................................... 1

Rules and Syntax ............................................................................. 1

Relative versus Absolute Cell Referencing ..................................... 1

Functions – Make Calculations Easier Than Using Formulas ............... 2

Syntax ............................................................................................... 2

The AutoSum Tool on the Home tab ............................................... 3

Insert Excel Functions – 4 Methods .................................................. 5

Insert Function Tool ........................................................................ 6

More Functions ................................................................................ 10

Logical If Function ........................................................................... 10

Logical AND Function combined with IF ........................................ 10

Logical OR Function combined with IF .......................................... 11

Concatenate Cells – Join Text Together .......................................... 11

Named Ranges .................................................................................. 12

Create a Range Name Individually .................................................. 12

Convert existing row and column labels to names............................ 12

Paste Names ................................................................................... 13

Delete or Add or Modify Range Names .......................................... 13

VLOOKUP ......................................................................................... 15

Syntax of VLOOKUP .......................................................................... 15

Worksheet Function Example ......................................................... 15

SUMIF ............................................................................................... 17

Syntax of SUMIF .............................................................................. 17

Worksheet Function Example ......................................................... 17

Worksheet Function Example #2 .................................................... 17

Worksheet Function Example #3 .................................................... 18
Formulas and Functions

There is a whole new formula bar in Excel 2013 to make entering Formulas and Functions easier.

Formulas

Rules and Syntax

All Formulas or Functions start with an “=”

Formulas use these operators (all of these operators can be found on the numeric keypad) and are calculated in the following order:

**“*” Multiplication**

**“/” Division**

**“+” Addition**

**“-” Subtraction**

Example of a Formula and its Answer:

=5+4*2  would the answer be 18 or 13?

**IMPORTANT**: The answer would be 13 because the Mathematical Hierarchy states the multiplication and division always occur before addition and subtraction unless parenthesis are used. If parentheses are used, that operation will override the default hierarchy. In other words, if you wish the answer to be 18, the formula must be = (5+4)*2.

Relative versus Absolute Cell Referencing

Relative Cell Reference

When you type a formula or function in a cell (like the one shown below – B2+C2) you would then generally copy or fill that formula to the cells remaining cells. If the formula were truly copied, each cell would contain =B2+C2 which, in this case, would not be what you want. You would want Excel to increase the row number for you as you copied the formula down to the other cells, which it does! Notice that =B2+C2 becomes =B3+C3 and then =B4+C4 etc. This same technique would increase/decrease column letters if you copied to the right or left. Relative cell referencing is the default in Excel.
Absolute Cell Reference

There are times, however, that you do NOT want relative cell addressing. Sometimes you need your reference to stay put. That is when Absolute cell addressing comes into play. To make a cell reference absolute, press F4 in the part of the formula you want to stay referencing the same cell. F4 makes an address absolute by placing dollar signs ($) in front of the column letter and row number (i.e. $B$4). This means that as you copy that formula, the reference to $B$4 will not change.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>January</td>
<td>February</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Ice Cream</td>
<td>100</td>
<td>10</td>
<td>=B2+C2</td>
</tr>
<tr>
<td>3</td>
<td>Cones</td>
<td>150</td>
<td>12</td>
<td>=B3+C3</td>
</tr>
<tr>
<td>4</td>
<td>Cherries</td>
<td>200</td>
<td>14</td>
<td>=B4+C4</td>
</tr>
<tr>
<td>5</td>
<td>Nuts</td>
<td>250</td>
<td>16</td>
<td>=B5+C5</td>
</tr>
<tr>
<td>6</td>
<td>Total</td>
<td>=SUM(B2:B5)</td>
<td>=SUM(C2:C5)</td>
<td>=SUM(D2:D5)</td>
</tr>
<tr>
<td>7</td>
<td>Tax Amount: Incorrect Formula</td>
<td>=B5*B10</td>
<td>=C6*C10</td>
<td>=D6*D10</td>
</tr>
<tr>
<td>8</td>
<td>Tax Amount: Correct Formula</td>
<td>=B5*E$10</td>
<td>=C6*E$10</td>
<td>=D6*E$10</td>
</tr>
</tbody>
</table>

Functions – Make Calculations Easier Than Using Formulas

Example – add B5 through B10
Using a formula: =B5+B6+B7+B8+B9+B10
Using the formula to Add a Range: =SUM(B5:B10)

Syntax

The syntax of a function is generally “=function name(range)” see examples below

Sum: =SUM(B5:B10)
Minimum: =MIN(B5:B10)
Maximum: =MAX(B5:B10)
Average: =AVERAGE(B5:B10)
Count: =COUNT(B5:B10)
The AutoSum Tool on the Home tab

**Sum a Column**

Using the example below:

1. **Click in cell B9** - the cell directly below the data.
2. Click the **AutoSum tool**.
   Notice that the cells it thinks you want to add have a marquis, a dotted line, around them.
3. If the cells you wish to add have a marquis around them, simply press **Enter** or click the AutoSum tool again to remove the marquis.

![Excel Sheet](image)

**Sum Multiple Columns**

4. Select all the cells where you want the totals to appear.

![Excel Sheet](image)

5. Click the **AutoSum tool**
   *(i.e. Select B9:F9 to sum all the rows at once, or F5:N9 to sum all the columns at once.)*

![Excel Sheet](image)
Sum Rows and Columns Simultaneously

6. Select the data you wish to add plus one extra row and one extra column. (so Excel knows where you want the totals to appear).

7. Click the AutoSum tool.
   (i.e. in the example above, select B5:F9 to sum all the rows and columns at once.)

Tip! If there are any gaps in your data (i.e. blank cells) it is a good idea to select the data in addition to the cell where you want the total to appear, before clicking the AutoSum tool. This will cause Excel to include all highlighted cells in the total, rather than stopping at the first blank cell. See example below.

Selecting only B9 before hitting Autosum includes only data up to the first blank cell in total.

Selecting B3:B7 before hitting Autosum includes all data in total.
Insert Excel Functions - 4 Methods

- The More Functions Option on the AutoSum tool
- The Insert Function tool on the left side of the Formula bar
- The Function Library on the Formulas bar
- Typing an equals and then using Excel’s formula entry help.

AutoSum: More Functions

![AutoSum More Functions](image)

Insert Function on the Formula Bar

![Insert Function on Formula Bar](image)

Function Library on the Formula Tab

![Function Library on Formula Tab](image)

Start Typing Function in Cell

![Start Typing Function in Cell](image)
Insert Function Tool

If you do not know how to enter a Function:

1. Click in the cell where you want the Function to appear and click either:
   a. the Insert Function tool on the Formula bar; or
   b. The Insert Function tool on the Formula tab.

2. The Insert Function Dialog box appears, allowing you to select any of Excel’s functions.
   a. You can search for a function by typing in a description of what you are wanting to find; or
      - To search for a function, type a description and press Go.
      - A definition will help you determine if the function selected is the one you need.
   b. You can search a reduced number of functions by selecting a category.
Select a Function Category to reduce the number of functions displayed or select All to view all functions.
3. Once you find the desired function, you can press Help to get great descriptions and examples of how to correctly use this function. Here is a great example of the Help for the **Count** function. It gives you a description of the function, followed by its syntax, other remarks, and 1 to 5 examples of how to use it in a worksheet!

**COUNT**

Counts the number of cells that contain numbers and omits numbers within the list of arguments. Use COUNT to get the number of entries in a range or array of numbers.

**Syntax**

```
COUNT(value1, value2,...)
```

**Arguments**

- **value1, value2, ...** are 1 to 255 arguments that can contain or refer to a variety of different types of data, but only numbers are counted.

**Remarks**

- Arguments that are numbers, dates, or text representation of numbers are counted.
- Logical values and text representations of numbers that you type directly into the list of arguments are counted.
- Arguments that are error values or text that cannot be translated into numbers are ignored.
- If an argument is an array or reference, only numbers in that array or reference are counted. Empty cells, logical values, text, or error values in the array or reference are ignored.
- If you want to count logical values, text, or error values, use the **COUNTA** function.

**Example**

The example may be easier to understand if you copy it into a blank worksheet.

[Insert table showing examples]

4. When you are done reading Help, you can click the “X” in the top right corner of the title bar. This brings you back to the Insert Function dialog box. If you then click OK, Excel will step you through inserting the Arguments as shown below. Click **OK** when done.
Exercise:

- Here is another example of using Insert Function to help with the Sum Function.

1. Click in the cell where the sum is to appear.
2. Click the Insert Function tool on the formula bar.
3. Select Sum for the function and click OK. The following dialog box appears.

![Function Arguments Dialog Box](image)

4. The Function Name and the ( )s appear in the formula bar. Either type in the desired range in the Number 1 text box; or

5. Make the dialog box collapse by clicking on the tool shown below and then drag across the range you want to select in the worksheet.

Your screen should look like this:

![Worksheet with Function Arguments](image)

6. When done click OK or press Enter.
More Functions

Logical If Function

The IF statement is used to test if the contents of a cell meet certain requirements. Returns one value if a condition you specify evaluates to TRUE and another value if it evaluates to FALSE. The result of the test can be a calculation or a string. See examples below.

**Syntax of If statement**

\[
= \text{IF}(\text{logical\_test}, \text{value\_if\_true}, \text{value\_if\_false})
\]

**Sample IF Statements**

Cell G3: \(=\text{IF}(F4>15000,"Great Job!","You're Fired!")\)

**Important!** If you want to leave the cell blank, you must still type quotes i.e. "".

Cell H3: \(=\text{IF}(F4>15000,F3*1.2,F4)\)

Logical AND Function combined with IF

Returns TRUE if all its arguments are TRUE; returns FALSE if one or more arguments is FALSE.

**Syntax of IF combined with AND statement**

\[
= \text{IF}(\text{AND}(\text{logical1}, \text{logical2}, ...), \text{true}, \text{false})
\]

**Sample IF AND Statements**

Cell G3: \(=\text{IF}(\text{AND}(D4>5000,E4>4000),"Great Job","Work Harder")\)

**Important!** If you want to leave the cell blank, you must still type quotes i.e. "".
Logical OR Function combined with IF

Returns TRUE if any argument is TRUE; returns FALSE if all arguments are FALSE.

Syntax of IF combined with OR statement

= If(OR(logical1,logical2, ...),true,false)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>East</td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>$1,200</td>
<td>$4,100</td>
<td>$5,610</td>
<td>$8,200</td>
<td>$19,110</td>
<td>Great Job</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>$2,200</td>
<td>$4,070</td>
<td>$6,600</td>
<td>$1,800</td>
<td>$14,870</td>
<td>Great Job</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>$3,200</td>
<td>$3,340</td>
<td>$5,800</td>
<td>$3,800</td>
<td>$16,140</td>
<td>Work Harder</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>$4,200</td>
<td>$2,400</td>
<td>$5,260</td>
<td>$4,800</td>
<td>$16,660</td>
<td>Great Job</td>
</tr>
</tbody>
</table>

Sample IF OR Statements

Cell G3: =IF(OR(D4>6000,E4>4000),"Great Job","Work Harder")

Concatenate Cells – Join Text Together

Joins several text strings into one text string.

Syntax of Concatenate statement

= CONCATENATE (text1,text2,...)

Sample CONCATENATE Statements

Named Ranges

Worksheets often have labels at the top of each column and to the left of each row that describe the data within the worksheet. You can use these labels within formulas when you want to refer to the related data. You can also create descriptive names that are not labels on the worksheet to represent cells, ranges of cells, formulas, or constants.

Create a Range Name Individually

7. Select the cell, range of cells, or nonadjacent selections that you want to name.

8. Click in the Name box at the left end of the formula bar.

9. Type the desired range name (i.e. Furniture) and press Enter.

Convert existing row and column labels to names.

10. Select the range that you want to name, including the row or column labels.

11. On the Formulas tab, in the Defined Names group, click Create from Selection.

12. In the Create Names from Selection dialog box, designate the location that contains the labels by selecting the Top row, Left column, Bottom row, or Right column check box.
Tip! A name created by using this procedure refers only to the cells that contain values and does not include the existing row and column labels.

Tip! If a column or row heading has a space in the name it will be replaced with an underline.

13. Click the drop down arrow on the Name box to see the names created.

Paste Names

14. Select an empty cell in a worksheet. 
   IMPORTANT! Leave room in several rows below selected cell to paste the list of range names.

15. Select Formulas, Use in Formula, Paste Names and then click Paste List. 
   A list of all names, and what they represent, appears.

Delete or Add or Modify Range Names

16. Select Formulas, Name Manager to Add or Delete or Modify Names.
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Refers To</th>
<th>Scope</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Furniture</td>
<td>&quot;Bar Stool&quot;,&quot;1000&quot;,...</td>
<td>=&quot;Vlookup Sum!&quot;</td>
<td>Workbo</td>
<td></td>
</tr>
<tr>
<td>FurnitureH</td>
<td>&quot;Bar Stool&quot;,&quot;Coffee&quot;,...</td>
<td>=&quot;Vlookup Sum!&quot;</td>
<td>Workbo</td>
<td></td>
</tr>
<tr>
<td>Table2</td>
<td>&quot;East&quot;,&quot;LCT&quot;,&quot;5000&quot;,...</td>
<td>=Table1!SA19:SE522</td>
<td>Workbo</td>
<td></td>
</tr>
</tbody>
</table>

Refer to:

- =Vlookup Sum!$F$39:$H$513
VLOOKUP

In Microsoft Excel, the VLOOKUP function searches for value in the left-most column of table_array and returns the value in the same row based on the index_number.

Syntax of VLOOKUP

\[
\text{VLOOKUP( value, table_array, index_number, [not_exact_match] )}
\]

value is the value to search for in the first column of the table_array.

table_array is two or more columns of data that is sorted in ascending order.

index_number is the column number in table_array from which the matching value must be returned. The first column is 1.

not_exact_match is optional. It determines if you are looking for an exact match based on value. Enter FALSE to find an exact match. Enter TRUE to find an approximate match, which means that if an exact match if not found, then the VLOOKUP function will look for the next largest value that is less than value. If this parameter is omitted, the VLOOKUP function returns an approximate match.

IMP! If you enter FALSE for the not_exact_match parameter and no exact match is found, then the VLOOKUP function will return #N/A.

Worksheet Function Example

Invoice Example on Left, Lookup Table Array on Right

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Item #</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1000 Bar Stool</td>
<td>175</td>
<td>4000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5000 Office Chair</td>
<td>275</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2000 Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3000 Desk</td>
<td>800</td>
<td></td>
<td></td>
<td></td>
<td>Bar Stool</td>
</tr>
<tr>
<td>8</td>
<td>4000 Lounge Chair</td>
<td>250</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5000 Office Chair</td>
<td>275</td>
<td></td>
<td></td>
<td></td>
<td>Desk</td>
</tr>
<tr>
<td>10</td>
<td>2000 Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td>Lounge Chair</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>600</td>
<td></td>
<td></td>
<td></td>
<td>Office Chair</td>
</tr>
</tbody>
</table>

\[=\text{VLOOKUP(B4, Furniture, 2, FALSE)}\]
ISNA

The VLOOKUP function will return an NA if a value is not found. To capture that error and return the value you desire, use a combination of the If and an ISNA functions as shown below.

IFNA

This is a new function in Excel 2016 and works the same as the =If(ISNA) function above only it dramatically shortens the function! See the new function below.
SUMIF

In Microsoft Excel, the **SUMIF function** adds all numbers in a range of cells, based on a given criteria.

**Syntax of SUMIF**

\[
\text{SUMIF}(\text{range, criteria, [sum_range]})
\]

- **range** is the range of cells that you want to apply the **criteria** against.
- **criteria** is used to determine which cells to add.
- **sum_range** is optional. It is the cells to sum. If this parameter is omitted, the **SUMIF function** uses **range** as the **sum_range**.

**Worksheet Function Example**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Item #</td>
<td>Description</td>
<td>Price</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1000</td>
<td>Bar Stool</td>
<td>175</td>
<td>5000</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3000</td>
<td>Desk</td>
<td>800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4000</td>
<td>Lounge Chair</td>
<td>250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>550</td>
<td></td>
</tr>
</tbody>
</table>

**Worksheet Function Example #2**

Using a static number in the formula and greater than or equal to operators.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Item #</td>
<td>Description</td>
<td>Price</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1000</td>
<td>Bar Stool</td>
<td>175</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3000</td>
<td>Desk</td>
<td>800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4000</td>
<td>Lounge Chair</td>
<td>250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>800</td>
<td></td>
</tr>
</tbody>
</table>
Worksheet Function Example #3

Using a cell address in the formula and greater than or equal to operators.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Item #</td>
<td>Description</td>
<td>Price</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1000</td>
<td>Bar Stool</td>
<td>175</td>
<td>4000</td>
</tr>
<tr>
<td>5</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3000</td>
<td>Desk</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4000</td>
<td>Lounge Chair</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5000</td>
<td>Office Chair</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2000</td>
<td>Coffee Table</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>800</td>
</tr>
</tbody>
</table>

C11 cell contains the formula: \( =\text{SUMIF(A4:A10,">" \& D4,C4:C10)} \)